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Abstract: Currently, worldwide, there is a significant increase in the use of computer systems and 

various information technologies, both in the production system and in education. The use of 

information technologies leads to an increase in work and productivity efficiency, in a short period of 

time. The paper, presents a method of diversifying clothing product models, using graphic libraries, 

created by using Corel Draw software, which can be used as a teaching tool in education, for the 

course "Computer aided design", as well as within the discipline "Designing series and model systems". 

The presented concept is structured and as e-learning educational materials, in order to improve the 

acquisition of the methodology for developing new models of clothing products. The method presented 

in the paper is based on an advanced study, theoretical and practical, of developing new models for 

designing clothing products in series and industrial systems. The method is based on the requirements 

imposed by the wearers. Also, this method may be introduced in the initial stage of creating new 

models, both within companies and in specialized institutions. The graphic library allows the use, 

modification and completion with new constructive-functional elements. As a further direction of 

development, it is proposed to complete the graphic library with functional-constructive elements that 

would allow obtaining new product model systems. Also here can be created 2D sketches, known as a 

technical drawing, which is an essential element of the garment. This method is suitable for any person 

working in the field of clothing design. She allows reducing the time for designing and manufacturing 

product series, reducing of costs for materials and work and increasing of flexibility and adaptability 

capacity of the design and manufacturing system, to changes in product requirements. 

Keywords: model system, module, software, e-learning, educational materials, product sketch 

INTRODUCTION 

In the current economic conditions, one of the vital problems for garment companies is the 

development and diversification of the clothing models assortment. Diversification must be done in 

conditions of quality assurance, optimization of production costs and efficient use of technical means.   

Compared to the design sectors in other branches of industry in which the number of models 

created annually reaches the orders of tens, throughout the garment industry, the design sectors solve 

hundreds and even thousands of models annually [1, 2, 3]. 

Also, the educational institutions, which train specialists for the fashion field, require the 

permanent creation of a new product model, which should correspond to the requirements of the 

wearers. 
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A possible solution to these problems, optimal in terms of advantages, is the widespread use 

of the principles of design of industrial systems of clothing product models combined with information 

technologies.  

This allows the diversification of new models of clothing products, in accordance with fashion 

trends, individual or group requirements of potential consumers, imposed on a certain range, 

destination and size, taking into account the technological possibilities. 

This paper presents an e-learning tutorial on how to use the functions and tools of Corel Draw 

software to develop and diversify clothing product models using information technologies. Using the 

steps explained, the student will be able to create original collections in the course "Computer aided 

design" as well as within the discipline "Design of series and model systems", study program "0723.1 

Technology and design of garments". 

The paper is designed as a teaching tool for students and provides the transition to online 

education. The methodology of using the presented tools, aims to make the product sketches and the 

necessary collection within the disciplines. It can be accessed on the university's moodle platform 

(http://moodle.utm.md/course/view.php?id=141). 

I. THEORETICAL ASPECTS  

Within the modular design principle, the constructive module is considered as an elementary 

structure. The constructive mode is a sector of the standardized construction which is characterized by 

a functional and informational interdependence and which is unified by the design principle [1,2, 5, 6]. 

The use of the principles of modular design of clothing products involves the development of 

final products from a number of unified components, while respecting the correspondence between 

them, in terms of functional, constructive and aesthetic parameters. The modulation ensures the 

possibility of structuring a product from a small number of standardized elements, which possess 

totally or partially, similar geometric and functional characteristics, elaborated in stages (figure 1). 

  

 

 

 

 

 

 

 

Figure 1. The levels of the process of clothing diversification 

 

Modularized design is based on the elementary structural unit - the constructive module - with 

the following definition: "standardized element of independent functional and informational 

construction that is unified according to the principle of realization". The module as an element of the 

construction is characterized by the following characteristics: 

• autonomy: the geometric characteristics of the module can be modified independently of the 

change of the characteristics of the other elements with the observance of the combination conditions; 

• complex hierarchical structure; 

• the field of use depending on the structural complexity: a construction can be divided into a 

limited number of lower order construction modules, and a complex structure of the module 

determines a lower possibility of application. 

The use of the principles of modularization in the design process of clothing products leads to 

increasing the degree of constructive and technological homogeneity of products, with a positive 

impact on raising the efficiency of the design process and increasing labor productivity.  

 

MODULAR 

DESIGN 

 

THE DESIGNING OF 

CONSTRUCTIVE 

MODULES 

THE ELLABORATION OF 

FUNCTIONAL, 

DECORATIVE AND 

CONSTRUCTIVE MODULES 
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II. APPLICATION OF MODULAR DESIGN TO THE DEVELOPMENT OF A 

SERIES OF NEW MODELS OF PRODUCTS INTENDED FOR PEOPLE 

WITH LOWER LIMB AMPUTEES 

The method of designing series of clothing models by applying modular design becomes 

effective if a number of requirements are met [1, 7]: 

1) The series of models of the same type must include 8-10 models; 

2) The constructive-decorative elements, the variants of the basic landmarks and the additional 

ones must be stable for a wide range of models. 

Initially, the types of modules for the chosen assortment are identified. Then the initial 

assembly units are identified - product body, sleeve, collar, waistband; which is presented on the flat 

image. The third stage consists in identifying the fragments of the derived assembly units - which 

present the information about the processing elements of the closing systems, of the parts terminations, 

of the pockets, as well as for the design of the basic parts variants. All the elaborated fragments are 

coded, and by overlapping the fragments of the technical drawings on the technical drawing of the 

basic assembly unit, the technical drawing of the new model is formed. 

The first stage of work involved establishing the initial data: product range, initial assembly 

units and derived assembly units (Table 1). 

 

Table 1. Establishment of the initial data needed to develop the series of models for people 

with lower limb amputations 

Selection criteria Elements 

Assortment Pants for people with lower limb amputation 

Initial assembly units Product body  

Waistband 

Derived assembly units 

 

 

Product length 

Main locking system 

Functionally constructive divisions 

Auxiliary locking system 

Pockets placed on the front  

Pockets placed on the back 

Detachable elements 

Folds, tweezers 

ETC. 

 

Two elements were established as initial assembly units: the product body and the product 

belt. The steps of elaborating the elements are presented to the students in electronic format. Table 2 

shows the sequence of elaboration of the product body. 

 

Table 2. The sequence of elaboration of the product body 

Execution steps 

1. The launch of the Corel Draw application 

2. Identification and import of the standard 

template, used as a basis for taking over the 

proportions: File → Import 
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2. Creating an additional layer for the first 

element – product body: Window → Dockers 

→Object → New Layar  

 

 
 

 

 
3. Drawing the element 

( Bezier ) 

 

 
 

4. Editing (Shape 

Tool) 

 

5. Copy (Ctrl+C and 

CTRL+V) and mirror 

(Mirror horizontally) 

 

 

6. Arranging (Pick 

Tool) 

 
and grouping intro a 

product (Grup) 

 

 

7. Locate and encode the item and save the document File → Save sau Save As 

 

The product body has 3 silhouettes: straight, semi-adjusted and adjusted silhouette (figure 2). 

 

Figure 2. Initial assembly unit - product body 
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The trousers product belt is a functional-constructive element, which can also present 

decorative elements. The following sketches were developed to diversify the model system (figure 3).  

 

 
 

Figure 3. Initial assembly unit - waistband 

 

These two units form the main contour of the product sketch, on which the derived assembly 

units will be placed.  

Derivative assembly units have been highly developed taking into account the needs of the 

wearer and fashion trends. Their graphical representation can be seen in table 3. 

 

Table 3. Derived assembly units 

Name and graphic representation of the assembly element 

1 2 

Product 

length 

 

Main 

locking 

system 
 

Functionally 

constructive 

divisions 
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Auxiliary 

locking 

system 

 

 

Pockets 

placed on the 

front  

  

Pockets 

placed on the 

back 

  

Detachable 

elements 

 

 
Superimpose

d and sewn 

materials, 

folds, creases 

 

 

Using this method, with the help of information technologies, a graphic library of functional-

constructive elements was developed, in accordance with the needs of people with lower limb 

amputations (Figure 4). 

 

 
Figure 4. Graphic library of functional-constructive elements 
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The formation of models by aggregating the necessary elements allows in a short period of 

time to obtain the sketch of the product pants, for women or men, who have various locomotor 

disabilities. Each model has a sketch and an identification code. 

 

 
 

 
 

 
   

Figure 5. System models developed by modular design 

 

Figure 5 shows the sketches of 9 product models, formed by overlapping assembly units. The 

first 3 product sketches are intended for people with leg amputations. They feature various types of 

closure systems that provide access to the prosthesis and abutment. 

The following 3 sketches are intended for people with knee amputations. Detachable and 

semi-detachable elements at the knee line are expected here, which offers convenience in the operation 

process. Closure systems placed in the side line with a length longer than the location of the prosthesis 

allow access to the prosthesis. 

The last 3 sketches are intended for people with hip amputations. The models feature locking 

systems along the entire side length of the product, which allows the product to be worn / undressed 

without removing the prosthesis / footwear. The length of the product up to the middle of the midline 

of the hips, allows trouble-free access to the prosthesis / abutment. Horizontal splits allow the pants to 

be transformed into shorts. 
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III. CONCLUSIONS 

In present, the information technology is an indispensable part of life, appearing as a necessity 

both in the production process and in the process of training and didactic research. 

Also, the pandemic triggered in March 2020 requires multiple changes in the study process by 

implementing the online or mixed study system. This has led to the need to use E-learning because it 

allows distance learning, flexibility of learning hours, accessibility to educational resources, etc. 

The creation of graphic libraries by applying the principles of modularized design with the 

help of information technologies allows: 

• reducing the time for designing and manufacturing product series; 

• reducing of costs for materials and work 

• increasing of flexibility and adaptability capacity of the design and manufacturing 

system, to changes in product requirements. 

As another direction for the development of this work it is proposed to develop a design 

software application. 
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